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[bookmark: _Toc197854086]Introduction
Digital Master (DM780) is a new program supporting the most commonly used digital modes, a replacement for PSK31 Deluxe. DM780 is closely integrated with Ham Radio Deluxe.
Too see what is new look at the Error! Reference source not found. (page Error! Bookmark not defined.).

Q: What does 780 signify?
A: A tribute to one of the finest computers ever built, the VAX 11/780.



Q: Why write Digital Master 780?
A: Many reasons:
Self-education,
Encourage people to try the digital modes,
Put something back into the hobby.
[bookmark: _Toc197854087]Supported Modes
The first release supports the main digital modes as well as SSTV:
PSK / QPSK,
CW,
DominoEx,
Hellschreiber,
MFSK,
MT63,
Olivia,
RTTY,
Throb.
The source for the digital mode DLL is available, if you can’t find it on the Ham Radio Deluxe website just ask and I’ll make sure it’s available.
Copyright and credits is available from the Help menu in DM780.
In DM780 you find all the features you expect of a modern program such as an integrated logbook, world map and web browsers. The DM780 philosophy is to get the UI working properly before more modes are added.
A lot of the decoder code is taken from Fldigi, a fine digital mode program for Linux. For more information: http://www.w1hkj.com/Fldigi.html . The author of Fldigi, W1HKJ has kindly allowed me to use his code for these modes.
[bookmark: _Toc197854088]Operating System Support
DM780 is designed for Windows 2000, XP and VISTA. Older versions of Windows such as Windows 98 are not supported.
There are no plans for Linux or Mac OS versions. The UI code cannot be made available; also it is not possible to port it to a UNIX-based operating system. If you want a UNIX / Linux solution either look at Fldigi (see above) or use WINE from http://winehq.org/ . 
[bookmark: _Toc197854089]VISTA
VISTA introduces a new API for soundcard access, fortunately the older NT / XP API is still available. DM780 uses the older API for the time being.
[bookmark: _Toc197854090]Hardware Requirement
Although one member of the test team has satisfactory results using a 500 MHz CPU and Windows XP a realistic minimum system would be a 1 GHz Intel CPU and 512 MB of RAM.
A high-end soundcard such as the M-Audio Delta 44 or Edirol FA-66 is not essential but recommended (I have had problems with my Delta-44 on VISTA). Currently I am using a TS-480SAT with an Edirol FA-66 and VISTA-32 – a great combination.
Please consider the excellent Navigator from http://usinterface.com/ .
If you are using a laptop be aware that the internal soundcard may be very poor indeed, consider the SignaLink USB from Tigertronics http://www.tigertronics.com/.
[bookmark: _Toc197854091]Meet The Users
The HRD and DM780 support forums are found at http://forums.ham-radio.ch/ .
The homepage is http://www.ham-radio-deluxe.com/ .
You do not need to register to view the forums! 


[bookmark: _Toc197854092]Getting Started

Follow these steps to configure DM780 and enjoy your first digital mode QSO.
[bookmark: _Toc197854093]Audio Interfacing
You need an audio interface to connect your rig's audio in/out to the computer's soundcard. This eliminates troublesome ground loops and prevents hum and noise from degrading the signals.
Audio interfacing can be done in so many ways that it would take days to plough through all the available information. It is possible to connect your radio directly to your soundcard without any form of isolating interface but this is not recommended.
[bookmark: _Toc197854094]Commercial Solutions
From England there are the ZLP Electronics DigiMaster interfaces, inexpensive, very well made and used with my TS-480SAT.


From Oregon USA, Tigertronics manufactures the SignaLink interfaces, used with my IC-703 and FT-817.
 

From Maryland USA the Navigator from USInterface.com is an excellent solution.


From Connecticut USA, West Mountain Radio provides the RIGBlaster solutions.

 
[bookmark: _Toc197854095]DIY
Here is a circuit recommended by Peter PH1PH (SK), this text was written by Peter in 2004.
"Here is a circuit that has proved its worth many times. It will work with any ICOM or Yaesu rig that has a 6-pin mini-DIN connector for external audio. It will of course work on just about any other rig that exists, but you will have to make changes to the connections to your radio. Please check the actual connections to the mini-DIN - I can accept no responsibility for damage to your rig should things go wrong. I have to say that the one that I built to this circuit worked perfectly well on my FT-817 and IC-703 without changes..."
"You should always use the rig's high-impedance audio output if there is one available: this supplies a constant signal level to the soundcard. Most rigs also have a TX audio connector independent to the microphone input: you are advised to use this input. Some commercial interfaces don't allow this: my recommendation is to avoid any interface requiring use of the microphone connector and speaker output unless there is no other option for getting signals in and out of the radio."

[bookmark: _Toc197854096]Tags
Enter values in the Tags window; these values are used in macros (shortcuts which save you entering the same text every time you have a QSO). The values are saved automatically.

If you want more tags select the QSO:General page of the Program Options and enable the option:
[_] Show multiple sets of tags (displays the Tags toolbar)
[bookmark: _Toc197854097]Soundcard
Select your soundcard as follows:
Either:
From the View menu select Soundcard,
In the Soundcard pane press the Options button.
Or:
Press F8 to display the Program Options (or select Program Options from the Tools menu),
Select the Soundcard page.


A good soundcard is recommended; some PC's come with very poor solutions built onto the mothercard (this is especially true for laptops). You can use the PC's default soundcard to get going, but the difference between a poor soundcard and a card such as the M-Audio Delta 44 or a Creative Audigy is like night and day. You will be able to decode signals much better with a good soundcard.
[bookmark: _Toc197854098]SignaLink USB
Tigertronics make a great external soundcard that you connect to a USB port on your computer; this is the SignaLink USB, which also provides an audio interface between the radio and PC to isolate your computer from your radio.
Available direct from Tigertronics and Martin Lynch & Sons (UK).

An advantage of a second soundcard is you can use the internal card for normal Windows sounds and the DM780 alarms.
[bookmark: _Toc197854099]USInterface Navigator
Just ONE USB cable to your computer controls EVERYTHING using ANY software.
Everything is built into the Navigator including a high speed sound card and monitor.
K1EL's newest Software Defined WinKey USB Keyer v21 is also built in.
The Navigator has the lowest noise level on the market... bar none.  Quit losing those weak signals and start working stations you couldn't copy before. 
MARS ALE users:  The Navigator Interface meets Microsoft standards for an audio codec device.  TRUE sampling rates can easily be set as high as 48 KHz.  
You can plug TWO (or more) Navigator Interfaces into the SAME computer while they each operate SEPARATE transceivers!  No other interface can accomplish that.
The case is 100% extruded aluminum.  (No thin bent aluminum or metal here.)   It's so robust you could put four more 706's on top.
Laser engraved, milled and drilled front and rear panels.  (No paint or decals.)


Navigator Console
DM780 has a special window for managing the Navigator. Operation should be obvious, below is the output from a Windows VISTA system.
For full information select the Help tab and read on…



[bookmark: _Ref163046714][bookmark: _Ref163046722][bookmark: _Toc197854100]Radio Control
DM780 uses Ham Radio Deluxe (HRD) for radio control. To set up a connection between DM780 and HRD:
In DM780 open the Radio display (select Radio from the View menu),
Press  Configure (the right-most button on the toolbar),
Read the help text, this contains everything you need to know!



To configure the radio interface:
Make sure Ham Radio Deluxe (HRD) is started and connected to a radio, you must use build 1317 or later.
In HRD select IP Server from the Tools menu, make sure the IP Server is started and is configured to start when HRD starts.

The IP Server window also shows the addresses assigned to your computer. If connecting from another computer in your network you usually select the first address.



In DM780 select Radio from the View menu, in the Radio pane press the Configure button.

In the Configure Radio Pane window:
HRD address - the address or name of the computer where HRD is running, localhost (or 127.0.0.1) if the local computer.
HRD port - the default port is 7809.
Press Connect to HRD.

If a connection can be established:
All buttons are enabled,
The Dropdown buttons are automatically loaded with the dropdown buttons shown the HRD's display,
The TX push button is automatically loaded (if available for your radio).
TS-480SAT - the TX Alt button is used for PTT via the rear connector.

To change a selection click on a button, then select an entry from the popup window. To clear the current selection, select the first entry '- - -'.
When you have finished defining your layout press Save. The definitions are saved in your local storage folder (from the Tools menu select Program Options, then select the Storage pane). For example, the IC-703 definitions are stored in DMRadioLayout_IC-703.xml .

In the Radio pane press the Connect button  to connect to HRD.
[bookmark: _Toc197854101]PTT
Normally you use HRD for PTT control, PTT is configured on the PTT pane of the Program Options (page 83).


[bookmark: _Toc197854102]COM Port
To use a COM port for PTT:
Select [X] via Serial (COM) port...
Select the COM port; this must not be in use by another program,
Select DTR, RTS or DTR and RTS.
When you switch to TX DTR and/or RTS are set (raised), when you return to RX they are cleared.
[bookmark: _Toc197854103]Ham Radio Deluxe
To use HRD the radio pane must be connected to HRD:
In the View menu select Radio
In the Radio pane press Configure and read the instructions!
[bookmark: _Toc197854104]Soundcard / VOX
If you are using a soundcard such as the SignalLink USB you can let the soundcard control the PTT or you can use the PTT built into your radio.
[bookmark: _Toc197854105]Your First QSO
If a QSO window is not displayed just press the QSO button. A typical QSO window layout is shown below.



[bookmark: _Ref163098479][bookmark: _Ref163098482][bookmark: _Toc197854106]QSO Window
The major components of the QSO window are:
Logbook (Add Log Entry) add an entry to DM780’s logbook. Click on the tabs to select the pages.

Macros, Tags, Modes:
Macros – pre-defined text that you use when composing the text you want to send.
Tags – information about yourself and your station, which is organized into fields, which in turn are used by macro definitions.
Modes – add modes currently supported by DM780.

Receive window – decoded text is displayed here.


Transmit window – the text you send is composed here. 
Waterfall - at the bottom you see the Waterfall, the red stripes are PSK31 signals. To select a signal, just click on the stripe.
[bookmark: _Toc197854107]More Detail
If the Waterfall is not displaying signals, check:
Your radio is switched on,
The correct soundcard is selected,
The correct input source is selected and enabled,
The cables are correctly connected to your radio and soundcard interface.
[bookmark: _Toc197854108]Mode
Select the correct mode. The default is PSK31, used in 95% or more PSK QSO’s. Select the mode with either:
The dropdown option in the receive window, or
The Modes pane.
[bookmark: _Toc197854109]Transmitting
Before you make your first test transmission you must decide how you will switch your radio between transmit and receive.
The options are:
PTT using a serial (COM) port,
PTT via Ham Radio Deluxe,
VOX (depends on your radio and soundcard interface).
To select PTT open the PTT page of the Program Options (selected from the Tools menu).
[bookmark: _Toc197854110]Test Transmission
It is very important that you transmit a clean, linear signal. Never, ever use any compression or ALC.
To transmit just press either:
Send (F1) – starts sending, when all text has been sent press Stop (F4).
Auto (F2) – starts sending, stops when all text has been sent.


When you start sending you will see the classic PSK ‘tramlines’ in the waterfall window:


When text is being sent the signal looks like this:


If you have configured your radio interface correctly your radio will switch to transmit mode when you start sending.
To stop sending immediately, just press Escape on your keyboard.
[bookmark: _Toc197854111]Using Macros
To select a macro either:
Select an entry from the Macros pane, or
Click an entry in the Macros bar.
The macros bar is usually the most convenient option. In the picture below the macros bar is the second strip of buttons.


In this example the text that has been sent is displayed with a blue strikethrough font.
To directly edit a macro right-click on the button in the macros bar.
[bookmark: _Toc197854112]Add Log Entry
Although you can type values into the fields in the Add Log Entry window, a faster option is to double-click on text in the receive window and select options from the popup menu.

 In this example the text UR4UP has been selected.
(Because UR4UP is an alphanumeric string and possibly a valid callsign, the entries in the popup window include the callsign lookup / QRZ options.)
To copy UR4UP into the Callsign field in the Add Log Entry window just select Callsign from the popup menu.
Hint: if you press Shift while double-clicking the selected text is copied into the Callsign field without displaying the popup menu.


The entries in the menu are:
Worked status,
Lookup using QRZ.com or DM780’s Callsign Lookup window,
The Add Log Entry fields – the main fields are supported,
Copy to clipboard,
Add Alarm – create an alarm from the callsign,
Google for the callsign.
[bookmark: _Toc197854113]
Add
This page contains the most commonly used fields.
Start and End Times
The times are usually shown using UTC, use the Program Options / Logbook pane to select either UTC or Local time. The time is always stored in the logbook using UTC.
Start
The start time for the QSO. If you check [_] Now the start time is updated with the current time.
In the Program Options / Logbook pane optionally select:
Update when adding callsign - the time is updated when you add a new value in the Callsign field if previously empty,
Update when adding logbook entry.
End
The end time of the QSO. If you check [_] Now the end time is updated with the current time. In the Program Options / Logbook pane optionally select:
Update when adding logbook entry.
Callsign
The station contacted. When you enter the callsign the Country is updated automatically. This field is mandatory.
Name
The operator's name, free-format text.
QTH
The operator's location, free-format text.
Locator
The Maidenhead locator, usually 6 characters, for example JN46pt.
Country
Updated automatically when you enter a callsign, the list shown corresponds to the latest DXCC list of countries.
Frequency
The current frequency, updated automatically from the Radio pane.
Band
The current band, determined from the frequency.
Mode
The current mode - the list contains the ADIF modes that are used for logbook import / export, awards, etc.
Sent
Sent has two fields: Report (example - 599) and Exchange (for contests).
Report
The standard, select from the dropdown or entered via the keyboard.
Exchange
To enable auto-incremented values in the Exchange field enclose the numeric value to be incremented inside square brackets. For example, if you enter [001] then the value added to the logbook and inserted in macros is 001 and this value is incremented to 002 when you press Add. The square brackets are ignored.
Remark
A free-format text field.
[bookmark: _Toc197854114]More
This page contains less frequently used fields.
Continent
Select from the dropdown list.
IOTA
Islands On The Air reference – the IOTA hompage is: http://www.rsgbiota.org/ .
Contest
If the contact is made during a contest, enter the name of the contest here.
A index, K index, Solar flux
The current space weather information available from NOAA via WWV. 
[bookmark: _Toc197854115]
My Station
This page contains information about your station. As you may have many configurations up to ten different station profiles are supported.
After you have entered values press Save.
Use the Copy To option to save the current values to a different profile.


[bookmark: _Toc197854116]Advanced QSO Options
[bookmark: _Toc197854117]Squelch
The Squelch control operates in a similar way to the squelch on your FM receiver; the signal is only decoded when the strength is equal to or greater than the squelch setting.



In the above example the squelch threshold is set to 25 (the available range is 0 to 100), the actual signal level is significantly higher.
[bookmark: _Toc197854118]AFC
Automatic Frequency Control ensures that you track a signal which may be drifting, also that your receive frequency is in the center of the signal.
[bookmark: _Toc197854119]Signal Quality
The quality of the received signal is shown in the vector data display.
	

	Vertical lines like this indicate a good PSK signal.

	

	Random lines like this indicate a bad PSK signal.


[bookmark: _Toc197854120]Multi-Channel Support
The standard QSO window supports 1, 2 or 3 receive channels.
	

	One channel (Main).

	

	Two channels, Main and Sub-A.

	

	Three channels, Main, Sub-A and Sub-B.



You can only transmit using the Main channel, Sub-A and Sub-B are receive only.

Use the  button to swap the contents of Sub-A or Sub-B with the Main channel.
An alternative to multi-channels is the SuperBrowser.
[bookmark: _Toc197854121]TX Lock / Split Mode



To enable split mode operation just press the TX lock button . Instead the main channel marker  is replaced with a transmit  and receive  marker.
To change either frequency click on the marker, then drag over a signal trace.
[bookmark: _Toc197854122]Repeats
To send text at a regular interval use the repeat option. Typically you use this option to send a CQ text on a normally quiet band such as 50 MHz.
There are two buttons associated with repeats:
	

	Select the repeat interval.

	

	Enable repeats.



When a repeat interval is selected a progress bar is displayed at the bottom of the transmit window (on the window’s status bar).

For example, with an 8 second interval: 
[bookmark: _Toc197854123]Waterfall
The waterfall is your tuning dial; you select the signal to decode and if in split mode your transmit frequency.


The waterfall display consists of:
Main toolbar,


Favourites toolbar,


Modes toolbar,


Markers,


Frequency,


Signal traces.


Toggle the toolbar visibility by right-clicking in the waterfall and selecting Show Toolbars from the popup menu.
[bookmark: _Toc197854124]Main Toolbar
The main toolbar options are:

	

	
Display mode – various algorithms to pull the signal trace out of the background noise. This does not affect the signal decoding.  shows the frequency spectrum.

	

	Show radio frequency (frequency of radio + audio offset).

	

	Rewind the display – replays the stored audio.

	

	Maximise the contrast (this does not affect the signal decoding).

	

	Enable decoder popups – the trace under the cursor is decoded, the result displayed in a small popup window. 



	

	Waterfall options.


[bookmark: _Ref163048420]Center Frequency
If you have a radio with a narrow filter you use this option to position the selected signal in the center of your filter.
In the main toolbar there are three buttons associated with this option:

	

	Enables center frequency operation.

	

	Click to apply center frequency.

	

	Click to undo the last change.




When enabled, the  marker is displayed in the waterfall. Click and drag this to the center of your narrow filter.


To move the selected signal to the center frequency, click the  button on the toolbar or double-click the  marker in the waterfall.

[bookmark: _Toc197854125]Favourites Toolbar
The favourites toolbar contains the frequencies you commonly use, it is provided to make switching between these frequencies as painless as possible.

	

	A favourite frequency (not selected).

	

	The currently selected favourite frequency.

	

	Adjust frequency by +/- 500Hz or +/- 2kHz.

	

	Start the favourites manager.



[bookmark: _Toc197854126]Modes Toolbar
The modes toolbar contains the modes you commonly use.

	

	A favourite mode (not selected).

	

	The currently selected mode.

	

	Start the modes manager.



[bookmark: _Toc197854127]Markers
The various markers you will see in the waterfall are shown below. To change a frequency click on, then drag the marker over a signal and release.
You must drag over the waterfall area where the signal traces are displayed, the cursor indicates the marker you are dragging.
To change the main channel frequency just click in the waterfall.

	

	
A current Main channel frequency. Split mode  must be off.

	

	The current channel Sub-A (VFO-A) frequency.

	

	The current channel Sub-B (VFO-B) frequency.

	

	The receive (RX) frequency if split mode is enabled.

	

	The transmit (TX) frequency if split mode is enabled.

	

	Center frequency – see Center Frequency on page 30. 


[bookmark: _Toc197854128]Appearance
The waterfall appearance is configured with the Waterfall:1 and Waterfall:2 pages of the Program Options (selected from the Tools menu).


The most commonly used options are Colour File and the Display Mode settings.
Select the colour file that is best for you, (I prefer Scope 1).
The display mode settings adjust the data to make the signal traces more prominent; this has no effect on the decoding. The default setting is shown in the above screenshot.
[bookmark: _Toc197854129]Options
There are three panes in the Program Options (page 83) used by the QSO window:
QSO:General,
QSO:Receive and
QSO:Transmit.
Familiarise yourself with the options on these panes. 

[bookmark: _Toc197854130]QSO Modes
When you select a new mode the options specific to that mode are displayed on an extra toolbar. This section explains the options for these modes.
[bookmark: _Toc197854131]Wikipedia
This is an excellent resource with a good description of digital modes.
[bookmark: _Toc197854132]PSK
http://en.wikipedia.org/wiki/PSK31
PSK is the most commonly used mode, there are no special options. 95% of traffic uses PSK-31, the rest using mainly PSK-63.
QPSK (a variant of PSK) is rarely used.
[bookmark: _Toc197854133]CW
http://en.wikipedia.org/wiki/Continuous_wave
CW is supported in four variants:
Standard CW where the radio is keyed via a serial or parallel port,
Modulated CW (MCW) where the tones are generated by the soundcard,
Using the KY command with Elecraft, Kenwood and Flex-Radio radios (read the PTT information below),
Using the K1EL Winkeyer.
All support the CW decoder.

[bookmark: _Toc197854134]Filter
The width of the software filter used to decode the incoming signal.
[bookmark: _Toc197854135]9->N
When checked sends N instead of 9 in reports copied from the Sent field of the ALE (add Log Entry) window.
[bookmark: _Toc197854136]Signal Analysis
This window is designed to assist the development of the CW decoder.
[bookmark: _Toc197854137]Options
The Mode:CW page of the Program Options is used to:
select the serial / parallel port used for keying your radio,
enable PTT,
control the waveform.
See the help text on the Mode:CW page for more information.
[bookmark: _Toc197854138]Winkeyer
DM780 supports all Winkeyer options with the exception of memory programming available with v2.0 and higher. 
Check Auto-connect if you want to automatically connect when the CW (WinKey) mode is selected.
Press Test to send the text TEST DE DM780.

Prosign Key Assignments

"	RR		/	DN
$	SX		:	KN
'	WG		;	AA
(	KN		<	AR
)	KK		=	BT
+	AR		>	SK
-	DU		@	AC

[bookmark: _Toc197854139]Hellschreiber
http://en.wikipedia.org/wiki/Feld-Hell
It is important to note that the output window is actually an image, not text so you cannot highlight any text!

[bookmark: _Toc197854140]Bandwidth
The receiver bandwidth filter, the default is 245Hz which is usable in almost all situations.
[bookmark: _Toc197854141]Screenshot
Takes a copy of the output window, displays this with the Windows default image viewer.
[bookmark: _Toc197854142]Browse
Browse the default pictures folder for screenshots.
[bookmark: _Toc197854143]Erase
Erases the output window.
[bookmark: _Toc197854144]Feld-Hell Club
A link to the main Hellscreiber club, http://feldhellclub.org/index.php .
[bookmark: _Toc197854145]Options
The other options are:
Font
Select the transmission font from the list built into DM780.


DX Mode
Transmits wider characters, for example using the Hell font with HB9DRV transmitted normally then in DX mode:

Hard Keying
When enabled transmits with a faster rise time (more ‘clicky’), the default is soft keying.
Uppercase
Transmits all text in uppercase.
Blackboard
Black background, white text, for example receiving HB9DRV normally then with Blackboard on:

Halfwidth
Displays half-width characters, rarely used.

Small
Reduces the size of the displayed image by 50%. The first example is normal size, the second small.


[bookmark: _Toc197854146]MFSK
http://en.wikipedia.org/wiki/Multiple_frequency-shift_keying
The only options are Reverse and exclusive to MFSK 16 there is a picture option.
TX Picture
The picture size is restricted to 320 x 256 as suggested by Patrick F6CTE in MultiPSK.
Pictures are either colour or greyscale, greyscale being transmitted three times faster than colour.
In this example the 320 x 213 pixel picture of a young programmer and his dog takes 204.5 seconds to send (68,160 pixels).
To insert a picture enter the tag <send-pic> in the transmit window, for example 'Here is a picture of my dog <send-pic>'.
The picture is sent using the size shown in this window; adjust the size by dragging the border of the window.
Smaller pictures are obviously sent faster.
[bookmark: _Toc197854147]MT63
http://en.wikipedia.org/wiki/MT63
The only option is the interleave, normally this is set to Long.
[bookmark: _Toc197854148]Olivia
http://en.wikipedia.org/wiki/Olivia_MFSK

The Olivia options are above.
[bookmark: _Toc197854149]RTTY
http://en.wikipedia.org/wiki/Radioteletype
The default RTTY setting is 45.45 baud, 170Hz shift. In Europe RTTY is generally send using USB irrespective of the frequency.

[bookmark: _Toc197854150]Reverse
In North America LSB is used on 7Mhz and below, hence the Reverse button.
[bookmark: _Toc197854151]Defaults
Restores the default settings.
[bookmark: _Toc197854152]UoS (Unshift On Space)
When this option is selected, received characters are switched from digits to letters after receiving a Space or LineFeed character.
[bookmark: _Toc197854153]LtoF
When enabled the Letters to Figures popup window is displayed (5-bit RTTY only).

[bookmark: _Toc197854154]Throb
There are no special Throb options.
[bookmark: _Toc197854155]SSTV
On December 14th, 2007 the bug bit thanks to MM-SSTV written by Makoto Mori, JE3HHT. Version 4 of DM780 contains the most common SSTV modes:
Martin 1 and 2 by Martin Emmerson,
Scottie 1, 2 and DX by Eddie Murphy,
P3, P5 and P7 (the Pasokon ‘P’ modes) by John Langner.
More modes such as Robot 26, Black and White and the PD modes will be added later.
SSTV is actually an analogue mode with an optional digital header (the VIS code which is sent before the image, identifying the transmission mode used) and FSK footer which contains the sender’s callsign.
For an excellent introduction see the Wikipedia entry for SSTV: http://en.wikipedia.org/wiki/Slow-scan_television .
[bookmark: _Toc197854156]Quick Start
If you just want to watch the pretty pictures:
Tune your radio to 14.230Mhz USB, 
Make sure your filter covers at least 1,000Hz to 2,400Hz, 
Wait! 
[bookmark: _Toc197854157]First Steps 
[bookmark: _Toc197854158]Dedicated Soundcard 
For SSTV and all soundcard modes in general it is strongly recommended that you use a second soundcard. With SSTV one often sees images transmitted with interruptions due to the SSTV soundcard playing Windows sounds created while the operator plays with other Windows applications. A soundcard dedicated to digital modes and SSTV is the best solution. 

[bookmark: _Toc197854159]Soundcard Calibration
When using SSTV it is essential that you calibrate your soundcard and enter the calibrated values in the SSTV Options pane Calibration.
Press the Options button on the SSTV toolbar or select Options from the SSTV menu. Select the Soundcard Calibration tab. Click Calibration and read the help text.


Receive Calibration


Transmit Calibration

The Soundcard Calibration window measures the soundcard data throughput using a NTP (Network Time Protocol) server as the time reference. (In a worst-case scenario you may need a few hours for very accurate calibration.) When the calibration is finished enter the values displayed in the Soundcard Calibration window.
In the above examples the Creative Sound Blaster PCI card has returned very stable values after only five minutes. A tenth of a Hertz (0.1) accuracy is enough. What is also interesting is that the transmit and receive values are not the same – but this is a very old 16-bit card! On my Edirol FA-66 there is no difference.
If you do not properly calibrate your soundcard then all received images will be displayed with a slant - although you can correct this yourself it becomes frustrating after a while. Also your transmitted images will be slanted – not what a good DM780 operator wants!
An alternate solution top using the NTP client is to adjust the slant on an image received from a station known for good calibration, for example VK6AAL. As you adjust the slant the sample rate used for decoding is shown in the slant window. 
[bookmark: _Toc197854160]Receiving Images 
The fastest way to receive your first images is to tune your radio to 14.230 MHz USB, set your filter so that the passband is at least 1000Hz to 2400Hz and just wait for an image to be displayed. For example with my K3 I use the 1.8kHz filter from 800Hz to 2600Hz. 
To adjust the incoming picture for slant either:
make sure Auto-slant is checked, or 
use the // / | \ \\ buttons, or 
drag the image - click on the received image with the left mouse button and drag left or right. 

To adjust the horizontal offset use the << < | > >> buttons.

[bookmark: _Toc197854161]Signal Detection 
Select the SSTV Options tab Detection. 
VIS codes - a digital VIS (vertical interval signaling) code can be sent before the image, identifying the transmission mode used. All SSTV software supports this. 
Sync pulses - if the VIS code is not detected due to QRM, fading or some other reason then the fall back solution is to detect the transmission mode by measuring the interval between consecutive 1200Hz sync pulses. Given enough sync pulses it is possible to compute and correct any slant. 
Normally you have both options enabled. 
[bookmark: _Toc197854162]Transmitting
You first create a set of templates with at least one template for each phase of a QSO:
Calling CQ,
Replying to a CQ call,
Sending QSO information (name, location RSQ),
Signing off (73).
To see your templates select TX: Templates in the lower tab bar. Click New to create a new template or select an existing template and click Edit. (See Template Editor on page 39 for more information.)
To load a template just double-click on the template.
When you press  a wave file is created in memory with the data to be sent. Your radio is switched to transmit using the option selected in the PTT page of the Program Options (selected from the Tools menu).

In this example about 55% of the image has been sent.
[bookmark: _Toc197854163]More Options
It is normal to:
prefix the image with a digital VIS (vertical interval signaling) code which identifies the transmission mode used, and
add your callsign in CW and FSK (frequency shift keying) after the image has been sent.
Sending the VIS code helps the other program detect the correct mode being used. If the VIS code cannot be detected or is missing then the only other solution is for the other program to attempt to detect the mode based on the sync pulses.
Sending in CW overcomes any legal requirements imposed on you by your licencing authorities, sending in FSK allows the other program to decode your callsign automatically and load it into the logbook.
In DM780 the VIS code is always sent, the CW and FSK identifications are enabled from the SSTV Options window (selected from the SSTV menu).
[bookmark: _Ref197768398][bookmark: _Toc197854164]Template Editor
Most SSTV formats are 320 x 256 pixels, DM780 allows you to create templates using double resolution 640 x 512.
[bookmark: _Toc197854165]Default
A default template contains just a banner with:
Locator
Program Title
Callsign

[bookmark: _Toc197854166]Background
To add a background image either:
From the Background menu button Select File or
Drag an image from Windows Explorer over the template.
Now decide whether the image should be stretched (or shrunk) to the template dimensions or just centered ‘as-is’.

[bookmark: _Toc197854167]Adding Text
Next add text areas. Just click anywhere im the template and drag to create a new area.

The new area is just above the two dogs. By default the text colour is black, the background is white. The default font is Arial.
Enter the text, for example CQ de HB9DRV.
Select special effects such as Border and / or Shadow. Be aware that a fancy template will not be as easy to read under poor conditions as a simple template.
 
In this example the text format has been modified:
4 pixel yellow border,
Transparent,
8 pixel shadow,
Centered horizontally.
You can use tags instead, for example for his callsign. Just click the Tags button and select from the popup menu.

Here tags are used for his callsign (the value is taken from the Add Log Entry window) and my callsign (the value is taken from the Tags).
[bookmark: _Toc197854168]Saving
Now press OK  - you are prompted for a filename. Enter something which describes the template’s use.


The template is shown with the current tag values, in this example GD4ELI has been entered in the Add Log Entry window.

[bookmark: _Toc197854169]FTP
To automatically upload received images to your web site using FTP select FTP from the toolbar.

There are separate parameters for uploading transmitted and received images, both of which are optional. In the above example only received images are uploaded.
Press Upload (Received) and Upload (Transmitted) to test the settings.
Optionally overlay Band, Mode and Frequency on the uploaded images. Here’s an example uploaded by G0HWC, a Scottie 2 image received on 20m on March 5th, 2008.


RX and TX upload are also enabled from the SSTV toolbar.

[bookmark: _Toc197854170]Image Window
The image window shows the received and transmitted images as well as optional webcam support.
[bookmark: _Toc197854171]Receive Window
	[image: ]
	Enable SSTV decoding

	[image: ]
	Enable automatic frequency control (image must have started with a VIS code)

	[image: ]
	Edit the TX template (or just double-click in the received image)
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	Stop decoding when sync pulses are no longer detected

	[image: ]
	Default the current image with the default Windows image viewer

	[image: ]
	Erase the window

	[image: ]
	Display the image with the experimental image post-processing
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	Save the image to a file
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	Enable image autosave

	[image: ]
	Reset the decoder, erase current image

	[image: ]
	Start transmit



[bookmark: _Toc197854172]Transmit Window
	[image: ]
	Edit the TX template (or just double-click in the received image)
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	Default the current image with the default Windows image viewer

	[image: ]
	Erase the window

	[image: ]
	Refresh the window

	[image: ]
	Select a background image (or just double-click an image in the Saved Imaged window).

	[image: ]
	The famous BBC test card used from 1967 to 1999

	[image: ]
	Reset the decoder, erase current image

	[image: ]
	Start transmit



[bookmark: _Toc197854173]Webcam
The webcam support uses the Windows AVICap video capture class, this supports most modern webcams.
Webcams are supported so that you can add a picture of your magnificent self to the transmit window with a single click.
[image: ]
In the above example an unknown programmer is shown slaving over a hot keyboard.
The options:
	[image: ]
	Start the webcam interface

	[image: ]
	Select the webcam source and format

	[image: ]
	Live preview
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	Save current image to the TX: Background Images window

	[image: ]
	Copy the current image to the TX template’s picture-in-picture field

	[image: ]
	Copy the current image to the transmit window



[bookmark: _Toc197854174]Callsign Lookup
Throughout DM780 you will frequently want to find details of another station. DM780 supports bother file and internet- lookups using QRZ.com.
Select Callsign Lookup from the Tools menu to configure callsign lookup.
The callsign lookup sequence is:
CD - HamCall,
CD - QRZ.com,
Internet using QRZ.com's subscription interface,
Internet using the QRZ.com detail page in a browser window.
As soon as any data is found the search stops.
[bookmark: _Toc197854175]CD Lookups
The CD's from http://www.qrz.com/ and http://hamcall.net/ are supported. The HamCall CD provides more data than the QRZ.com CD. For best performance copy the files from CD to hard disk.
[bookmark: _Toc197854176]QRZ.com
[bookmark: _Toc197854177]Subscriptions
Access to the QRZ data online requires a valid subscriber login consisting of a username and password, and a current, active subscription with QRZ. You can use your QRZ.com username and password for seven days from the date of first lookup. For more information please visit http://online.qrz.com/.
[bookmark: _Toc197854178]Web Browser
Lookups are performed by opening the callsign's detail page in an Internet Explorer browser which is built into DM780. This is not very efficient, the QRZ subscriptions method is far better.
[bookmark: _Toc197854179]Donations
Just like Ham Radio Deluxe, QRZ.com has considerable costs associated with providing the online callsign database.
Please consider donating to QRZ.com by visiting http://www.qrz.com/i/donations.html. Another option is to subscribe to QRZ.com - this information is found by visiting the site.
[bookmark: _Toc197854180]Logbook
Every modern program has a built-in logbook; DM780 is no exception. The database engine is taken from Ham R adio Deluxe; the operation will be familiar to anyone who has used Ham Radio Deluxe.
There are two logbook windows:
Quick log - a docking pane that shows the most recent entries, designed as a quick reference window.
Main logbook - this is the option you select for general logbook maintenance.


 Whichever window you use – TAKE REGULAR BACKUPS!
[bookmark: _Toc197854181]Quick Log
Select Display Quick Log from the Logbook menu or Quick Log from the View menu to display this window.
Much simpler than the main logbook window, this is a docking pane with only the most basic options available, selected from the toolbar. 
[image: ]
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	Fit to Text

	

	Refresh

	

	Modify

	

	Delete

	

	Max Entries

	

	Plot

	

	Backup

	

	Enable Filter (find by callsign)

	

	Options




If the  Find option is enabled then any callsign entered in the Add Log Entry window is automatically applied here.
To try this:
Make sure the Quick Log window is displayed.

 Find must be selected.
In the Add Log Entry window enter a callsign in the Callsign field.
All previous QSO’s with this station are now shown.
[bookmark: _Toc197854182]Main Logbook
Select Display Main Logbook from the Logbook menu or press the Logbook button on the main toolbar.
[image: ]
Note: The selection fields at the top of the window are enabled when the Advanced button is pressed.
All options are selected from either the Logbook menu, the context (right-click) menu or the toolbar.
[bookmark: _Toc197854183]Layout
The column layout is user-definable. Select the columns and the order in which they are displayed.
Save up to four custom layouts.
[image: ]
[bookmark: _Toc197854184]ADIF
Amateur Data Interchange Format (ADIF) files are used to exchange QSO information between logging programs. In DM780 you can save (export) the logbook to an ADIF file and load (import) an ADIF file into the logbook.
Export
Create and ADIF file to send your records to another logging program, Logbook of The World (LoTW) or eQSL.cc.

[image: ]
After selecting the output file you select the fields to be included in the file.
ADIF / LoTW: the fields supported by ADIF 2.0 (also required by LoTW).
ADIF + Ham Radio Deluxe: all fields.
EQSL: only the fields required by eQSL – this makes the ADIF file smaller and the eQSL upload faster.
An example of an ADIF file containing a single record is shown below:

#++
#
#   Digital Master 780 version 1.0 build 1431
#   http://www.hb9drv.ch
#
#   Free software for ever!
#
#   Created:  28-Mar-2007 20:54:55
#   Database: C:\Documents and Settings\…\HRD Logbook 19-Mar-2007 230254.mdb
#   Exported: 1 record
#
#--

<ADIF_VERS:3>2.0
<PROGRAMID:14>HamRadioDeluxe
<PROGRAMVERSION:22>Version 1.0 build 1431
<EOH>

<call:5>NP2KW <qso_date:8:d>20070201 <time_on:6>091822 <band:3>40m <mode:5>PSK31 <rst_sent:4>599  <a_index:2>18 <cont:2>NA <dxcc:3>285 <freq:8>7.034500 <gridsquare:6>FK77np <iota:6>NA-106 <k_index:1>4 <my_city:8>Wickford <my_cnty:5>Essex <my_country:7>England <my_cq_zone:2>14 <my_gridsquare:6>JO01go <my_iota:6>EU-005 <my_itu_zone:2>27 <my_lat:8>51.60545 <my_lon:7>0.54845 <my_name:5>Terry <my_postal_code:8>SS11 8XN <my_rig:33>Yaesu FT1000 MkV + Balanced tuner <my_street:18>2 Coltishall Close <name:5>Manny <operator:5>G6CNQ <owner_callsign:5>G6CNQ <qth:18>St Croix, Vi 00821 <rst_rcvd:4>599  <sfi:2>89 <station_callsign:5>G6CNQ <time_off:6>092252 <tx_pwr:8>40 watts <EOR>
Import
Use this option to load and ADIF file into your logbook database.
[image: ]
When importing an ADIF file the band information may be missing, if you check the option:


the band is recomputed.
If the DXCC information is missing you can generate this by checking:

.

The first step is to load the file; the records are shown in the bottom half of the window. If you are satisfied that the information shown is correct you save this information to your database.
[bookmark: _Toc197854185]Cabrillo
Many contests require the log in Cabrillo format (why they can’t just load an ADIF file is a mystery).
[image: ]
Not all Cabrillo templates are supported - these are added as required.
[bookmark: _Toc197854186]Merge HRD
You can load (import) records from another logbook providing it is already in the HRD format.
Typical use would be to import a database created during a contest of an expedition to an exotic location or while using your laptop from a portable site. 
[image: ]
Duplicate QSO’s are ignored when you press Load.
[bookmark: _Toc197854187]Google Earth
Selected entries can be sent to Google Earth, a fantastic program available for free download.
[image: ]

The interface to Google Earth is a Keyhole Markup Language (kml) file.
Note: Home information is taken from the Tags window shown in the QSO Windows.
[image: ]
[bookmark: _Toc197854188]Options
The logbook options are selected from the Logbook entry. The options should be self-explanatory, a few of the more important options are discussed below.
[bookmark: _Toc197854189]Countries File
Nothing stays the same forever, especially country prefixes. The Countries File option on the Files, Backups page is used to either load a new file or edit the current file.
[bookmark: _Toc197854190]eQSL.cc
I use eQSL.cc as it has a simple and fast programming interface – try it.
[bookmark: _Toc197854191]QSO Forwarding
Forward QSOs to DXbase as they are added to the DM780 logbook. Please note that the interface supplied by DXbase does not allow DM780 to send over date and time files, DXbase uses the current time.
[bookmark: _Toc197854192]Analysis
The current analysis shows DXCC, IOTA, QSO and Grid squares by band and mode.
Printing is supported!



[bookmark: _Toc197854193]SuperBrowser
The aim of the SuperBrowser is to display as many PSK QSO’s as possible.
Not only display – you can have a QSO using the SuperBrowser!
A standard display is shown below. From left to right:
Frequency,
Waterfall,
Active channels.
At the bottom you see the status bar, containing:
Current soundcard selection,
Active channel count / total channels,
Hold time before a channel is no longer shown,
Audio rewind when a new signal is detected,
CPU used by the background SuperBrowser processing,
Overload status (incoming signal level is too high),
Current AFC setting.

[image: ]
In this example the callsign RX1CV has been reliably identified, so is shown at the beginning of the channel.


The  icon indicates that you have not worked RX1CV on this band. If you have worked RX1CV the  icon is displayed.
[bookmark: _Toc197854194]Options
[bookmark: _Toc197854195]Main Toolbar
The main toolbar options are:
	

	Mode selection

	

	Squelch level and decoding threshold



	

	AFC

	

	Display the QSO windows – you can transmit with the SuperBrowser!

	

	Plot

	

	Backup

	

	Show radio frequency

	

	Enable alarms

	

	Maximise contrast

	

	Waterfall display mode

	

	Number of channels

	

	Enable info popups showing station worked status (band, time etc.)

	

	Options



[bookmark: _Toc197854196]Favourites Toolbar
The favourites toolbar contains the frequencies you commonly use, it is provided to make switching between these frequencies as painless as possible.

	

	A favourite frequency, not selected.

	

	The currently selected favourite frequency.

	

	Adjust frequency by +/- 500Hz.

	

	Start the favourites manager.



[bookmark: _Toc197854197]Transfer To QSO Window
Double-click on a channel to transfer the settings and data to a main QSO window (not the built-in QSO window).
Press shift and click on a channel to open the SuperBrowser QSO window (if not already open) and select the channel.
[bookmark: _Toc197854198]QSO Window
Press the  button to display the SuperBrowser QSO windows:
Add Log Entry,
QSO: RX,
QSO: TX.
These windows are the same as those in the main QSO window (page 19).
Click anywhere in the channel text (not the callsign or icons) to select a different channel.
Click anywhere in the waterfall to change the frequency of the current channel.
[bookmark: _Toc197854199]Options
Press F8 to display the Program Options (or select Program Options from the Tools menu), then select the SuperBrowser:1 or SuperBrowser:2 page to view the available options.
[bookmark: _Toc197854200]Visual
The SuperBrowser:1 page concentrates on the appearance of the SuperBrowser.

[bookmark: _Toc197854201]Operation
The SuperBrowser:2 page concentrates on the way the SuperBrowser operates.


[bookmark: _Toc197854202]PSK Propagation Reporter
This is a project to automatically gather reception records of PSK activity from the SuperBrowser window and then make those records available in near real-time to interested parties - typically the amateur who initiated the communication.
Idea and implementation by Philip Gladstone, N1DQ.

From the Tools menu select PSK Reporter, then Options.


Destination Address and Port - use the default values.
Enable updates - must be checked.
Log update - if checked entries are added to the logfile (see View menu).
When a report is sent it uses the Callsign, Locator and Antenna values com from the Tags window.
The way that it works is that many amateurs will run a client that will monitor received traffic for callsigns (the pattern 'de callsign callsign') and, when seen, will report this fact. This is of interest to the amateur who transmitted and they will be able to see where their signal was received. The pattern chosen is typically part of a standard CQ call. The duplicate check is to make sure that the callsign is not corrupted.
The way that this would be used is that an amateur would call CQ and could then (within a few minutes) see where his signal was received. This can be useful in determining propagation conditions or in adjusting antenna and/or radio parameters. It will also provide an archive of reception records that can be used for research purposes.
To show the current reports select PSK Reporter, then Homepage.
An example of the output is shown below. Here we see the stations received by HB9DRV on 20m on the morning of March 6th, 2008.


[bookmark: _Toc197854203]Web Browsers
DM780 offers two styles of web browser:
A fully featured full-sized browser, and
A small docking mini-browser.
The options available in the mini-browser are a subset of those available in the full-sized browser.





Both browsers use on the Internet Explorer engine, any settings you make with Internet Explorer are automatically applied here. 
Options are selected from the toolbars and the Browser menu. As an experienced Internet user you will already be familiar with the operation of a web browser.

[bookmark: _Toc197854204]World Map
The world map is used to:
Plot the greyscale line,
Show a locator square overlay,
Plot stations as you work them,
Plot locators as they are detected in the SuperBrowser.

The options are selected from the World map menu and the toolbar.
[bookmark: _Toc197854205]Alarms
In the QSO windows you use alarms to monitor received text for special callsigns, locators or any string you want.
[bookmark: _Toc197854206]Manager
To define alarms select Alarms Manager from the Tools menu.


The options are selected from the toolbar.
	

	Callsign
	Create a ‘quick’ alarm definition from a callsign.

	

	New
	Create a new alarm definition.

	

	Copy
	Copy the currently selected definition.

	

	Edit
	Edit the currently selected definition.

	

	Delete
	Delete the currently selected definitions.

	

	Up
	Move the currently selected definition up.

	

	Down
	Move the currently selected definition down.

	

	Test
	Text the enabled definitions.

	

	Import
	Import from another Alarms set.

	

	Load
	Load from a file.

	

	Save
	Save to a file.


[bookmark: _Toc197854207]Editor
The alarms editor is very simple to use, however you must pay attention to the regular expression syntax.


[bookmark: _Toc197854208]Match Text
The value in the Match field is a regular expression, examples are shown below. In the table * represents any character, <spaces> matches one or more spaces.

	Match Text
	Description

	HB9DRV
	*HB9DRV*

	\sGD[0-9][a-z]{2,3}\s
	Any callsign following a space (\s) starting with GD, then a digit (0 to 9), then 2 or 3 letters (a to z).

	DM780|Digital Master 780
	*DM780* or (|) *Digital Master 780*

	PSK31\s+Deluxe
	*PSK31<spaces>Deluxe*

	\sCQ\s+CQ\s|\sCQ\s+DE\s
	<space>CQ<spaces>CQ<space> or
<space>CQ<spaces>DE<space>

	\sCQ\s+DX\s
	<space>CQ<spaces>DX<space>

	VK[0-9][a-z]{2,3}|ZL[0-9][a-z]{2,3}
	Any VK or ZL callsign



The most commonly used regular expression syntax is:
	Expression
	Matches

	.
	Any Character

	[]
	Character in Range

	[^]
	Character Not in Range

	^
	Not

	|
	Or

	*
	0 or More Matches

	?
	0 or 1 Matches

	+
	1 or More Matches

	{2,4}
	2 to 4 Matches

	
	

	Some Examples
	

	\s
	Single Space

	\s+
	1 or More Spaces

	[a-z]
	A to z

	[a-z0-9]
	A to z or 0 to 9

	[abx]
	a, b or x

	[0-9]
	0 to 9

	[347]
	3, 4 or 7

	CQ\s*DX
	CQ DX

	[gm][a-z]?[0-9][a-z]{2,3}
	A UK Callsign starting with G or M

	hb9drv
	HB9DRV

	[a-z]{2}[0-9]{2}[a-z]{2}
	Locator (e.g. JN46pt)



If you use the dropdown menu you can build your own regular expressions.
Use the Test option to check your definitions.
[bookmark: _Toc197854209]
Testing Alarms
Use the Test option to compare a string with the enabled definitions.
[image: ]



Enter text in the top window, then press Test. The alarm definitions which match are flagged with , those which do not match with .
Check [_]Include sound effects if you want to hear the alarms.
[bookmark: _Toc197854210]SuperBrowser Colours
Optional colours applied to the SuperBrowser channel which generated the alarm.
[bookmark: _Toc197854211]Text-To-Speech
DM780 alarms use Microsoft’s Text-to-Speech solution. This is usually installed by default on Windows XP and VISTA systems.
If you computer doesn’t have Text-to-Speech installed you can download it from Microsoft’s website.

[bookmark: _Ref163050650][bookmark: _Toc197854212]Identities
The concept of multiple identities used in DM780 is similar to that found in Outlook Express.
Typical use of multiple identities:
At home,
Portable,
Contest.

[image: ]All identities share the same logbook but are otherwise unique (macros, tags, layouts).
Identity support is selected from the File menu.

The Main Identity is used by default. To create / delete an identity use the New and Remove options.
[image: ]
To reset an identity (remove all files and clear registry settings) press Reset. You cannot reset the Main Identity.
Note: The logbook database and registry settings are never removed.
When you press Select DM780 closes and restarts using the selected identity.
[bookmark: _Toc197854213]Options
When defining an identity you must decide whether to share common definitions with the main identity.
The definitions you can share are:
Alarms,
Favourites,
Macros and
Tags.
For example, here at the HB9DRV HQ a TS-480SAT and TS-2000 are both used with DM780, but only the TS-480SAT PTT is enabled via HRD whereas the TS-2000 is controlled via a SignaLink USB.
So I have two Identities that differ only in the Program Options (specifically the PTT page), otherwise they are identical.
[bookmark: _Toc197854214]Logfile
The logfile window contains diagnostic information used when there are problems with DM780. You will not normally display this window.

[image: ]


[bookmark: _Toc197854215]Macros
Macros are used when composing text to be sent during a QSO. Using macros avoids repetitive typing thus ensuring fewer errors.
[image: ]Typical uses for macros:
Calling CQ,
Information about your station,
Starting a reply.
Macros are selected in the QSO windows from either the Macros window or the Macros toolbar.








[bookmark: _Toc197854216]Manager 
To define Macros start the Macros Manager: 

Select Macros Manager from the Tools menu,
Press Define in the Macros window, or
Press Define in the toolbar (right-most button).



[image: ]
Here you define the macros shown in the macros window and the macros toolbar.
The top toolbar contains the Manager options:
[image: ]
New – create a new macro,
Copy – copy the selected macro,
Edit – edit the selected macro,
Delete – delete the selected macro,
Up, down – move the selected macro,
Import – load definitions from another macro set,
Set Title – the title for the current macro set,
Defaults – load the default definitions shipped in DM780,
Load – load definitions from a file,
Save – save definitions to a file.

The next toolbar shows the enabled definitions as they are shown in the QSO windows.
[image: ]
[bookmark: _Toc197854217]Editor
The Macro editor window is shown below.
Note: Right-click on an entry in the macros window or macros toolbar to launch the editor without starting the Macros Manager.

[image: ]

The components of a macro are:
Title
As shown in the Macros window.
Short Title
As shown in the Macros toolbar.
Group
Macros are grouped together in the Macros window (shown in QSO windows).
 [X] Enabled
Only enabled macros are shown in the Macros window and toolbar.
Definition
See below.
Enable By Mode
If you want the macro to be available for specific modes only.
Tags (My Info)
The tags shown in the Tags pane of the normal QSO window, this is information about yourself and your station.
Log (His Info)
The fields shown in the Add log Entry window where you enter the QSO details before adding to the logbook.
Special
Special tags such as date and time.
[X] Erase TX window…
If enabled the contents of the transmit window are erase unless either Shift is pressed or you are transmitting.
[X] Send immediately
If enabled the macro is sent as soon as it is applied, typically used in a CQ macro.
[X] Start on new line
If enabled the macro always starts on a new line when added to the transmit window.
[bookmark: _Toc197854218]Definition
[image: ]
A macro contains free-format text and optional tags. A tag is an item of information, for example his callsign or your output power.
To insert a tag just double-click on an entry on one of the tag lists.
The currently supported tags are shown at the bottom of the editor window. There are three lists:
Tags (My Info)
These fields come from the Tags window in the QSO windows.
Logbook (His Info)
These fields come from the Add Log Entry window.
Special
These are pre-defined.
A tag is enclosed in <>. The actual substitution is made when the macro is selected into the transmit window.


Special Tags
More information about the special tags.
	date
	Inserts the current date using local time and the user’s Windows settings for short dates.

	time
	Inserts the current time using local time in ISO 8601 format (HH:MM:SS).

	date_utc
	Inserts the current date using UTC (GMT) time and the user’s Windows settings for short dates.

	time_utc
	Inserts the current time using UTC (GMT) time in ISO 8601 format (HH:MM:SS).

	Time_hhmm
	Inserts the current time using UTC and the HHMM format.

	add-log
	The same as pressing the Add button in the Add Log Entry window – the QSO is added to the logbook.

	Reset-log
	The same as pressing the Reset button in the Add Log Entry window = the window contents are reset.

	erase
	Erases the transmit window.

	repeat
	The same as pressing the Repeat button.

	stop
	Stops sending.


[bookmark: _Toc197854219]Radio Control
A radio control macro contains commands sent to Ham Radio Deluxe to configure your radio, for example to set a special filter. The text in the definition is not added to the input (TX) window. These definitions are specific to the radio you are using.
The tag {{RADIO-CONTROL must appear anywhere in the macro definition. If you have added this by mistake just remove the lines containing the tag.
The easiest way to add entries is to use the Radio window, as you select options in the Radio window the options are sent to Ham Radio Deluxe and the corresponding text is added to the definition (remember to press the Connect button in the Radio window). Only add one entry per line.
As with all macros lines starting with # are treated as comments and are not passed to Ham Radio Deluxe. Blank lines are ignored.
Commands
There are four command types:
Center frequency on/off,
Dropdown (menu) buttons,
Normal press buttons,
Sliders.

To simplify the command parsing any spaces in the button / slider names are replaced with a tilda (~). Slider entries contain the radio title, this is for historical reasons.

Center Frequency
center-on
center-on 1750
center-off

To enable the current center frequency option in the waterfall enter center-on. 
Note: the center frequency option must be enabled (checked). To specify the center frequency just add the frequency in Hz after the center-on tag, for example center-on 1750.
To undo the center frequency option and restore the previous radio frequency enter center-off.
The center-on and center-off text must be the only entry on the line. Typically you combine these options with a filter setting, for example when enabling the center frequency option a narrow filter is selected, when undoing a normal (wide) filter is selected.

#++
#
#   {{RADIO-CONTROL
#
#   For the TS-2000
#
#   Set the center frequency to 1250Hz, adjust DSP filtering
#   to Low = 1000Hz, High = 1400Hz.
#
#--

center-on 1300
Set slider-pos TS-2000 DSP~low~cut 11    //  DSP low cut = 11
Set slider-pos TS-2000 DSP~high~cut 0    //  DSP high cut = 0

Dropdown-Button
When you select an entry from a dropdown button it is added to the end of the definition. Existing entries for the same dropdown button are not overwritten as a dropdown button can contain unrelated commands.

Press Button
When you press a button the editor first tries to replace an existing entry for this button; if there is no entry then a new entry is added to the end of the definition.

Sliders
When you move a slider the editor first tries to replace an existing entry for this slider; if there is no entry then a new entry is added to the end of the definition.
[bookmark: _Toc197854220]Video ID
A popular and most useful option is sending text at the beginning of you transmission where the text is displayed on the other station’s waterfall.


Here the test HB9DRV PSK31 is being sent to identify the transmission mode.
To add video text at the start of the macro add <ident:HB9DRV  PSK31>, this must be the first test in the macro.
Here is an example where 73 is sent using Video ID when signing off:

#++
#
#   The end of the QSO, 73 and thanks for the QSO.
#
#--
#
<ident:73>
<LOG:Callsign> de <Callsign> 73 ...

An alternative to adding a video ID to a macro is to use the Video ID button in the transmit window (which must be enabled in the Program Options page QSO:Transmit).
[bookmark: _Toc197854221]Preview
The macro is displayed as it will be sent when the cursor is placed over an entry in the macros window or macros toolbar.
In the example below the cursor is over the Station button. Text derived from tags is shown in italics.


[bookmark: _Ref163050797][bookmark: _Ref163051436][bookmark: _Toc197854222]Program Options
DM780 is a fully featured program with many displays; as a result the level of user customization is very extensive.

You can customize almost every part of DM780 by selecting Program Options from the Tools menu.
The Programs Options window is modeless – while it is displayed you can still use DM780, also any changes you make are applied immediately.





[bookmark: _Toc197854223]eQSL.cc
The integrated logbook will automatically upload new contacts to eQSL.cc if enabled here.



[bookmark: _Toc197854224]Themes And Skins
The Theme and Skinning panes define the appearance of DM780. Although the defaults should be acceptable there is no harm in selecting an appearance you find more appealing.
Skins add an extra load on your CPU and graphics card, so if you are using an older PC (less than 1 GHz CPU) you may consider disabling skins.
[bookmark: _Toc197854225]Storage
This pane provides easy access to the file and registry storage used by DM780. The folder names depend on the currently selected identity (page 71).


 Don’t mess around with the registry – if you don’t know what you are doing leave it alone!



[bookmark: _Toc197854226]Radio Interface
The radio interface configuration is described in the section Radio Control on page 16.
[bookmark: _Toc197854227]Favourites
Use favourite frequencies to switch between commonly used digital mode frequencies. 
[bookmark: _Toc197854228]Manager 
From the toolbar select Manager from the Favourites menu:
 

The favourites manager is a simple list of frequencies that are displayed in the dropdown menu and in the favourites toolbar in the QSO transmit windows.
[image: ]
Options are selected from the toolbar.
[bookmark: _Toc197854229]Editing
Editing is simple – a definition consists of a title, a short title (used in toolbars), the frequency in Hertz and the modes which use the definition.
[image: ]


[bookmark: _Toc197854230]Release Notes
The release notes page is selected from the Help menu. It contains a detailed list of changes together with the change date.
[image: ]

[bookmark: _Toc197854231]Various
A few other options worthy of mention are discussed here.
[bookmark: _Toc197854232]Time Synchronisation
DM780 has a built-in NTP Client for exact time synchronisation.
Select Time Synchronisation from the Tools menu.
[image: ] 

Select the update frequency – every 6 hours should be fine.
Select three time servers; these will be tried in turn until one of them returns valid data.
Press Test to test the corresponding server. The logfile window shows output similar to that below.

10:50:32 NTP Client: Server address  = time.windows.com
10:50:32 NTP Client: Server address  = 207.46.197.32, port = 123
10:50:32 NTP Client: Receive port    = 7123
10:50:32 NTP Client: Receive timeout = 10 seconds
10:50:32 NTP Client: Request sent
10:50:32 NTP Client: Reply received
10:50:32 NTP Client: Client ...: 08:50:32.392 UTC/GMT
10:50:32 NTP Client: Server ...: 08:50:32.405 UTC/GMT
10:50:32 NTP Client: Offset ...: 13 milliseconds
10:50:32 NTP Client: Computer time updated 

Your Windows account must have the system-time privilege to be able to update the computer time.
[bookmark: _Toc197854233]WWV Updates
From the Tools menu look at the WWV menu to enable display of Space Weather and Sunspot Data in the status bar.
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Reply Reply HimdeMePseK  HimdeMe-K <LOG Callsign> de <Calsign> <Callsign> pse kn
Reply  Report Name, OTH RST, Name, QTH <LOG Callsign> de <Callsign>\ninHi <LOGNam
Reply  Station Station <LOG Callsign> de <Callsign>nyn<LOGName>.
Info WX Wi Weather here is <Weathers temp is <Temperatu
Closing BTU BTU S0 BTU <LOGName>, <LOG Callsign> de <Call
Closing 73 73 <LOGCallsign> de <Callsign> 73 <LOGName> ¢
Closing 73 (long) 73 <LOGCallsign> de <Callsign> 73 <LOGName> ¢
Closing 73mas 73¥mas <LOG Callsign> de <Callsign> 73 and thanks for |
7) 73 (ong) Closing 73 (videa) 73 <ident73><LOG Callsign> de <Calsign> 73 <LO(
8) 73 (viden) Various Testing Testing Testing Testing Testing de <Callsign> <Callsign

3) Him de Me
4) Him de Me Pse K
5) Report, Narne, QTH
6) Station

Closing

Macroset  ® Defeut i
Oset2 [ Send his firstname only (LOGNAME)
Oset3
Osetd
Osets
Oseth

Show 'Send Immediately’ taolbar ican
Show 'Erase TX Window toalbar ican

Show 'Radio Cantrol' taolbar ican

[ Show macro settitle
Toolarstle: OButons  © Popups
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CallCQ Reply Closing
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Title:
Short Title: *

Group:*

Definiion: *
(= reqirec)

© _Help

4 Samples

Station
Station (Toolbar buttons)

Reply

)

=
#

# A1l the toys in use at my station.
#

#e

#

<LOG:Callsign> de <Callsign>

<LOG:Name>, my station
Radio <Radiocd, <Power>,
Software : HRD + <Program>
Antenna : <Antemna>
Operator : Created 1957,

<Interface>

licenced 1974

My QSL is OK via eQSL.cc or via the bureau.

BIU <LOG:Callsign> de <Callsign> kn <stop>

Tags (My
Callsign
Name

Age
Locator
QTH
E-Mail
HomePage
Clubs
Radio
Antenna
Power
Computer
Interface
Arrecenriss

Log (His Info)
L0G:Callsign
L0G:Name
LOG:OTH
L0G:Locator
L0G:Frequency
L0G:Band
L0G:Mode
L0G:Sent
L0G:Sent_Rpt
L0G:Sent_Exch
L0G:Revd
L0G:Revd_Rpt
L0G:Revd_Exch
T 0 Ramarie

[send immediately

rase TX windaw (notit SHIFT pressed or ransriting)

[CIstarton newline

Right-click an a Macro entry in the QSO window's Macros listto

editthe macro.

Double-click a tag name to add itto the definition

Special
add-log

date

date_utc
erase

erase-rx

qso+

qso-

gso-mode
gso-mode-count
gso-total-count
repeat
reset-log
send-pic

aton

Radio Cantrol

Enable By Mode
oW
DorninoEx
Hell
MFSK
MTE3
OLMvIA
PSK
QPsK
RTTY
Throls

Description

add to logbook

date (local, IS0)

date (UTC, 1S0)

erase tx window

erase rx window

increment QSO (comtest) counter
decrement QSO (contest) counter
current mode (ADIF format)

total number of 0SOs in the loghook for the current mode
total number of 0SOs in the logbook
enable repeats

reset logbook

start sending a MFSK16 picture
sfane cendina

Load Textfram File

Insert Video ID.
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#+t
#

# A1l the toys in use at my station.
#

#e

#

<LOG:Callsign> de <Callsign>

<LOG:Name>, my station
Radic  : <Radio>, <Power>, <Interface
Software : HRD + <Program>

<antenna>
Created 1957, licenced 1974

Antenna
Operator

My QSL is OK via eQSL.cc or via the burea

BIU <LOG:Callsign> de <Callsign> kn <stop
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Tags (My Info)
Callsign
Name
Age
Locator
OTH
E-Mail
HomePage
Clubs
Radio
Antenna
Power

Logbook (His Info)
L0G:Callsign
L0G:Name

LOG:OTH
L0G:Locator
L0G:Frequency
L0G:Band

L0G:Mode

L0G:Sent

L0G:Sent_Rpt
LOG
LoG

:Sent_Exch
Revd

Special
date

time
date_utc
time_utc
time_hhmn
add-Tog
reset-log
erase
repeat.
stop

Description
date (local, IS0)
time (local, IS0)
date (UTC, 1S0)
time (UTC, 1S0)
time (UTC, HHMM)
add to logbook
reset logbook
erase window
enable repeats
stops sending
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Default Frequency Mode | Load Save s

Allfrequencies are USE

General

© Steps,

Enable Modes
oW

DorminaEx
DorminaEx
DorminaEx
DorminaEx
DorminaEx
DorminaEx
DorminaEx

O Hell

M Hell

Full Title
1.828.000 MHz
3500.000 MHz
7.000.000 MHz

10.110.000 MHz

14.000.000 MHz

18.075.000 MHz

21.025.000 MHz

24.895.000 MHz

28.000.000 MHz

50.100.000 MHz
3584000 MHz
7.038.000 MHz
7.042.000 MHz
7.072.000MHz

10.148.000 MHz

14.076.000 MHz

14.078.000 MHz
1.804.000 MHz
3574000 MHz

Short Tile
1.828
3500
7.000

10110
14,000
18.075
21.025
24895
28.000
50.100
3584
7038
7042
7072
10148
14076
14078
1.804
3574

ey Aradio connection is required

Toolbar Layout

OButtans (by mode)

Frequency (Hz)
1826000
3500.000
7.000.000

10110000
14000000
16.075.000
21025000
24695000
26000000
50100000
3564000
7.036.000
7.042.000
7.072.000
10148000
14076000
14078000
1804000
3574000

®Popups (by band)
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Favourite

10.110.000 MHz

Short Tile:  10.110

Frequency: | _._10.110.000

Modes:  OAll
®or
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CIHell

(Used in Favourtes toolbar)
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Release Notes

Build Numbers

The release notes are updated as changes are made, not every time a new build is created. When you
download a kit it is very normal for there to be no notes for the same build number you have downloaded, so
just look at the notes for previous builds.

The build number is in fact the number of days since May 1st, 2003 - the day when the first line of Ham Radio
Deluxe source code was written.

So if the release notes are updated on Saturday August 4th, 2007 but the kit is built on Sunday August 5th,
2007 the most recent notes will be for build 1560 (Saturday), not 1561 (Sunday).

Version Date
1.1 build 1832 May 2nd, 2008

# Type Description
1 Change The logic for the Next / Prev favourite buttons in the radio display and radio toolbar
has been changed to try and show the next / previous value for the current mode.

This is not an exact science as there can be mode than one mode active at a time,
but anyway it's an attempt at least!

Version Date
1.1 build 1832 May 2nd, 2008

# Type Description

1 Change Alarms window logic reworked to ensure new entries are displayed and highlighted,
windows also made resizable (this includes the Alarms Test window).

2 Change The SuperBrowser QSO window now remembers its own squelch value rather than
inheriting the general SuperBrowser value.

3 |Fix When using the Video ID option with Olivia the current bandwidth / tones is now
displayed.

4 Change If an image cannot be displayed in the SSTV folders (maybe it's corrupted) then a
small red cross is displayed to indicate a bad image (as Windows doe: various
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me Synchronisation

Synchronise fime with & NTP server.

Update every |1 hour

Server1: timewindows.com

Server. [tme-anistgov

Server3: [time-b nistgov

Port 7123 (for replies, usually 7123)

Results are shown in the lagfile
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\i) Space Weather Updates

WWY broadcasts space weather information which provides an
indication of current propagation.

“This information is shown in the main status bar, for more
information visit the Space Environment: Center website,

Enzble atomatic Lpdates?

oFE
OnNo
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